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About this Paper

This is the OSSSC Combined Recruitment Examination (CRE) 2025 Preliminary written test (Advt. IIE-120/2025-3219) for the posts of
Revenue Inspector, ICDS Supervisor, Village Agricultural Worker, Junior Assistant, Assistant Revenue Inspector, Amin & Statistical Field
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Exam pattern: 100 questions · 100 marks · 90 minutes. Sections: Mathematics 20, General Studies 20, English 20, Odia 15, Computer
15, Logical Reasoning 10. Marking: +1 correct, −0.25 wrong.
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Paper Set 1 · 16 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ମଞ୍ଜୁ  ସରୋଜି ନୀ ମାର୍କେ ଟରୁ  ₹1,000 ରେ ଗୋଟି ଏ ଜ୍ୟାକେଟ କ୍ର ୟ କରି  ଏହାର ମୂ ଲ୍ୟକୁ
P% ଅଧି କ ଧାର୍ଯ୍ୟ  କଲେ । ଏହାପରେ ସେ (0.4 × P) % ରି ହାତି  ପ୍ର ଦାନ କରି ବା ସତ୍ତ୍ୱେ (0.4
× P) % ଲାଭ ପ୍ର ତି ଶତ ହାସଲ କଲେ । P ର ମୂ ଲ୍ୟ କେତେ?

A.  40

B.  45

C.  50

D.  35

✓

Q2 Quant
ରମେଶ ଏବଂ ରଞ୍ଜନ ଯଥାକ୍ର ମେ ₹45,934 ଏବଂ ₹52,496 ନି ବେଶ କରି  ଏକ ବ୍ୟବସାୟ
ଆରମ୍ଭ କରି ଥି ଲେ । ଯଦି  ବର୍ଷ  ଶେଷରେ ମୋଟ ଲାଭ ₹13,440 ହୁ ଏ, ତେବେ ଲାଭରେ
ରଞ୍ଜନଙ୍କ ଭାଗ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹6,184

B.  ₹6,676

C.  ₹7,026

D.  ₹7,168

✓

Q3 Quant
140 m ଦୈ ର୍ଘ୍ୟ  ବି ଶି ଷ୍ଟ ଗୋଟି ଏ ଟ୍ରେ ନ ବି ପରୀତ ଦି ଗରେ ଦୌଡ଼ୁଥି ବା 160 m ଦୈ ର୍ଘ୍ୟ
ବି ଶି ଷ୍ଟ ଅନ୍ୟ ଏକ ଟ୍ରେ ନକୁ  ଅତି କ୍ର ମ କରି ବା ପାଇଁ  15 ସେକେଣ୍ଡ ସମୟ ନି ଏ । ଉଭୟ ଟ୍ରେ ନ
ମଧ୍ୟରେ ଆପେକ୍ଷି କ ବେଗ (m/s ରେ) କେତେ?

A.  20

B.  15

C.  10

D.  16

✓

Q4 Quant
ଜଣେ ବ୍ୟକ୍ତି  ସ୍ରୋ ତର ଅନୁ କୂ ଳରେ 2.5 ଘଣ୍ଟାରେ 18 km ଦୂ ରତା ଅତି କ୍ର ମ କରି ପାରନ୍ତି  ଏବଂ
8 ଘଣ୍ଟାରେ ଫେରି ଆସି ପାରନ୍ତି  । ସ୍ରୋ ତର ବେଗ ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

A.  2.145 km/h

B.  2.255 km/h

C.  2.365 km/h

D.  2.475 km/h

✓

Q5 Quant
A ଓ B ଏକାଠି  ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  13 ଘଣ୍ଟାରେ ଶେଷ କରନ୍ତି  । ଏକାକୀ A ଏହାକୁ  26
ଘଣ୍ଟାରେ କରି ପାରି ବେ । କାର୍ଯ୍ୟ  ଶେଷ କରି ବା ପାଇଁ  ଏକାକୀ B କେତେ ସମୟ ନେବେ?

A.  39 ଘଣ୍ଟା

B.  19.5 ଘଣ୍ଟା

C.  26 ଘଣ୍ଟା

D.  32.5 ଘଣ୍ଟା

✓

Q6 Quant
3 ଟି  କଲମ ଏବଂ 2 ଟି  ନୋଟବୁ କର ମୂ ଲ୍ୟ ₹46 ଅଟେ, ଯେତେବେଳେ 5 ଟି  କଲମ ଏବଂ 4
ଟି  ନୋଟବୁ କର ମୂ ଲ୍ୟ ₹78 ଅଟେ । ଗୋଟି ଏ କଲମ ଏବଂ ଗୋଟି ଏ ନୋଟବୁ କର ମୋଟ
ମୂ ଲ୍ୟ କେତେ?

A.  ₹16

B.  ₹18

C.  ₹24

D.  ₹20

✓

Q7 Quant
ଲବଧାଙ୍କ 10, 20 ଓ 30 ର ଅନୁ ରୂ ପ ଭାର ଯଥାକ୍ର ମେ x, 3x ଏବଂ 2.5x ଅଟେ,
ଯେଉଁ ଠାରେ x > 0 ଅଟେ । ଲବଧାଙ୍କର ଭାରି ତ ମାଧ୍ୟମାନ ନି ର୍ଣ୍ଣ ୟ କର (ନି କଟତମ
ପୂ ର୍ଣ୍ଣ ସଂଖ୍ୟା ପର୍ଯ୍ୟ ନ୍ତ) ।

A.  23

B.  22

C.  24

D.  21

✓

Q8 Quant
50 ର 20% ଅପେକ୍ଷା 65 ର 30% କେତେ ଅଧି କ ଅଟେ?

A.  9.5

B.  4.5

C.  6.5

D.  11.5
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✓

Q9 Quant
A ଓ B ଏକାଠି  କାମ କରି  5 ଦି ନରେ ଗୋଟି ଏ କାର୍ଯ୍ୟ  ଶେଷ କରି ପାରି ବେ । B ଏକାକୀ 8
ଦି ନରେ ସମାନ କାର୍ଯ୍ୟ  ଶେଷ କରି ପାରି ବ । A ଏକାକୀ କେତେ ସମୟ (ଦି ନ ରେ) ରେ
କାର୍ଯ୍ୟ ର ତି ନି ଗୁ ଣ ଶେଷ କରି  ପାରି ବ?

A.  40

B.  80

C.  120

D.  160

✓

Q10 Quant
₹13,372 କୁ  X, Y ଏବଂ Z ମଧ୍ୟରେ ଏପରି  ଭାବେ ବି ଭକ୍ତ କରାଯାଇଛି  ଯେ ଯଦି  ସେମାନଙ୍କ
ଭାଗରୁ  ₹31, ₹12 ଏବଂ ₹67 ବି ୟୋଗ କରାଯାଏ ତେବେ ସେମାନଙ୍କ ପାଖରେ 15 : 14 :
9 ଅନୁ ପାତରେ ଟଙ୍କା ରହି ବ । ବି ୟୋଗ ପରେ X ର ଭାଗ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹5,235

B.  ₹5,135

C.  ₹5,385

D.  ₹5,185

✓

Q11 Quant
ଯଦି  ₹8600 କୁ  ଅର୍ଦ୍ଧ ବାର୍ଷିକ ଭାବେ ଚକ୍ର ବୃ ଦ୍ଧି  ହେଉଥି ବା ବାର୍ଷିକ 20% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ
ହାରରେ ନି ବେଶ କରାଯାଏ, ତେବେ 1 ବର୍ଷ  ପରେ ସମୂ ଳସୁ ଧ କେତେ ହେବ?

A.  ₹10,406

B.  ₹10,096

C.  ₹10,024

D.  ₹10,094

✓

Q12 Quant
ΔOPQ ରେ, ∠O = 65° ଏବଂ ∠P = 73° ଅଟେ । ∠P ଏବଂ ∠Q ର ସମଦ୍ୱି ଖଣ୍ଡକ ଦ୍ୱୟ
ତ୍ରି  ଭୁ ଜର ଭି ତରେ R ବି ନ୍ଦୁ ରେ ପରସ୍ପରକୁ  ଛେଦ କରନ୍ତି  । ∠PRQ ର ମାପ କେତେ?

A.  120°

B.  120.5°

C.  122°

D.  122.5°

✓

Q13 Quant
ଦୁ ଇଟି  ସଦୃ ଶ ତ୍ରି  ଭୁ ଜର ଦୁ ଇଟି  ଅନୁ ରୂ ପ ବାହୁ ର ଦୈ ର୍ଘ୍ୟ ର ଅନୁ ପାତ 19 : 13 ଅଟେ ।
ଉଲ୍ଲି ଖି ତ କ୍ର ମରେ, ଏହି  ଦୁ ଇଟି  ତ୍ରି  ଭୁ ଜର କ୍ଷେତ୍ର ଫଳର ଅନୁ ପାତ ନି ର୍ଣ୍ଣ ୟ କର?

A.  361 : 169

B.  19 : 13

C.  13 : 19

D.  169 : 361

✓

Q14 Quant
ବାର୍ଷିକ 8% ସରଳ ସୁ ଧ ହାରରେ ମୂ ଳଧନ ₹3000 ରୁ  ସୁ ଧ ₹340 ମି ଳି ବା ପାଇଁ  କେତେ
ସମୟ (ମାସ ରେ) ଲାଗି ବ?

A.  17

B.  14

C.  15

D.  21

✓

Q15 Quant
ସରଳ କର : 213 - 2 × (20 + 13) + 96

A.  243

B.  235

C.  252

D.  246

✓

Q16 Quant
ଜଣେ ଦୋକାନୀ ଏକ ସାମଗ୍ରୀ କୁ  ଏହାର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ଉପରେ 15% ଏବଂ 10% ର ଦୁ ଇଟି
କ୍ର ମି କ ରି ହାତି  ଦେବା ପରେ ₹1530 ରେ ବି କ୍ରି   କରନ୍ତି  । ଯଦି  ସେ କୌଣସି  ରି ହାତି  ନ
ଦେଇଥାନ୍ତେ, ତେବେ ସେ କ୍ର ୟମୂ ଲ୍ୟ ଉପରେ 25% ଲାଭ ଅର୍ଜ ନ କରି ଥାନ୍ତେ । ସାମଗ୍ରୀ ର
କ୍ର ୟମୂ ଲ୍ୟ (₹ ରେ) କେତେ ଅଟେ?

A.  1600

B.  1620

C.  1580

D.  1700
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✓

Q17 Quant
କ୍ଲା ର୍କ  ଏବଂ ରୋହି ତଙ୍କ ଦ୍ଵାରା ଏକ ବର୍ଷ  ଶେଷରେ ଅର୍ଜିତ ମୋଟ ₹4,500 ଲାଭରୁ  କ୍ଲା ର୍କ  ନି ଜର ଅଂଶ ସ୍ୱରୂ ପ ₹3,000 ପାଇଲେ । ଯଦି  କ୍ଲା ର୍କ  6 ମାସ ପାଇଁ  ₹10,000 ବି ନି ଯୋଗ କରି ଥି ଲେ,
ଯେଉଁ ଠାରେ ରୋହି ତ ନି ଜର ଅର୍ଥ ରାଶି  ସମଗ୍ର  ବର୍ଷ  ପାଇଁ  ବି ନି ଯୋଗ କରି ଥି ଲେ, ତେବେ ରୋହି ତଙ୍କ ଦ୍ଵାରା ବି ନି ଯୋଗ କରାଯାଇଥି ବା ଅର୍ଥ ରାଶି ର ପରି ମାଣ କେତେ ଥି ଲା?

A.  

B.  

C.  

D.  

✓

Q18 Quant
ସରଳ କର: 95 - { (-20) × (-3 - 4 - 17) } ÷ [ 8 × (8 + (-3) × (-5)) ]

A.  

B.  

C.  

D.  

✓

Q19 Quant

ଯଦି  ହୁ ଏ, ତେବେ  ର ମୂ ଲ୍ୟ କେତେ ଅଟେ?
A.  28

B.  15

C.  10

D.  18

✓

Q20 Quant

25 ର  ଅପେକ୍ଷା 75 ର 65% କେତେ ଅଧି କ ଅଟେ?

A.  43.75

B.  40.75

C.  37.75

D.  41.75
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GA

✓

Q21 GA
2025 ମୋନାକୋ ଗ୍ରା ଣ୍ଡ ପ୍ରି  କ୍ସ ସ୍ପ୍ରି ଣ୍ଟ ରେସ ରେ ଫର୍ମୁ ଲା 2 ରେସ ଜି ତି ଥି ବା ପ୍ର ଥମ ଭାରତୀୟ
ଡ୍ରା ଇଭର କି ଏ ହୋଇଥି ଲେ?

A.  ଜେହାନ ଦାରୁ ୱାଲା (Jehan Daruvala)

B.  ନାରାୟଣ କାର୍ତ୍ତିକେୟନ (Narain Karthikeyan)

C.  କରୁ ଣ ଚାନ୍ଧୋକ (Karun Chandhok)

D.  କୁ ଶ ମାଇନି  (Kush Maini)

✓

Q22 GA
ତରଳ ପଦାର୍ଥ କୁ  ଗରମ କଲେ କ'ଣ ହୁ ଏ?

A.  କଣି କାଗୁ ଡ଼ି କ ଗତି ଜ ଶକ୍ତି  ହାସଲ କରନ୍ତି  ଏବଂ ଦ୍ରୁ ତ ବେଗରେ ଗତି  କରନ୍ତି  ।

B.  ଆନ୍ତଃ-କଣି କା ମଧ୍ୟରେ ଦୂ ରତା ହ୍ରା ସ ପାଇଥାଏ

C.  କଣି କାଗୁ ଡ଼ି କ ଧୀରେ ଗତି  କରନ୍ତି ।

D.  କଣି କାଗୁ ଡ଼ି କ ଶକ୍ତି  ହରାଇଥାନ୍ତି  ଏବଂ ତଳେ ବସି ଯାନ୍ତି

✓

Q23 GA
ଅଗଷ୍ଟ 2025 ରେ ଭାରତ ସରକାରଙ୍କ ଦ୍ଵାରା ଆରମ୍ଭ ହୋଇଥି ବା AI ଟୁ ଲର ନାମ କ’ଣ,
ଯାହାକି  ଭାରତୀୟ ଭାଷାରେ ସଭାର ଗଠନମୂ ଳକ କାର୍ଯ୍ୟ ବି ବରଣୀ (minutes of
meetings) ପ୍ର ସ୍ତୁତ କରି ଥାଏ?

A.  SabhaPrabha

B.  SabhaSanket

C.  SabhaSaar

D.  SabhaAI

✓

Q24 GA
ଜୁ ନ 2025 ରେ ଘୋଷଣା କରାଯାଇଥି ବା ଓଡ଼ି ଆ ଭାଷା ପାଇଁ  ରାଜକି ଶୋର ପାଢ଼ୀଙ୍କ କେଉଁ
କୃ ତି  ବାଳ ସାହି ତ୍ୟ ପୁ ରସ୍କାର 2025 ଲାଭ କରି ଛି ?

A.  ଜେଜେଙ୍କ ଗପ ଗଣ୍ଠି ଲି

B.  ଗପ କଳି କା

C.  ଗୀତା କହେ ମି ତ୍ର  କଥା

D.  କେତେ ଫୁ ଲ ଫୁ ଟି ଚି

✓

Q25 GA
ଆଖି  ଭି ତରକୁ  ପ୍ର ବେଶ କରୁ ଥି ବା ଆଲୋକର ଗତି ପଥକୁ  ବି ଚାର କଲେ ସର୍ବା ଧି କ ପ୍ର ତି ସରଣ
ପାଇଁ  କେଉଁ  ଅଂଶ ଦାୟୀ ଅଟେ ଏବଂ ଏହା ପରେ ମୁ କୁ ରି କାରେ ସୃ ଷ୍ଟି  ହେଉଥି ବା ପ୍ର ତି ବି ମ୍ବର
ପ୍ର କୃ ତି  କ'ଣ ଅଟେ?

A.  କ୍ରି  ଷ୍ଟାଲାଇନ ଲେନ୍ସ , ଆଭାସୀ ଏବଂ ସଳଖ 

B.  ସ୍ଵଚ୍ଛପଟଳ, ବାସ୍ତବ ଏବଂ ସଳଖ

C.  ସ୍ଵଚ୍ଛପଟଳ, ବାସ୍ତବ ଏବଂ ଓଲଟା  

D.  କ୍ରି  ଷ୍ଟାଲାଇନ ଲେନ୍ସ , ଆଭାସୀ ଏବଂ ଓଲଟା 

✓

Q26 GA
ସେପ୍ଟେମ୍ବର 2025 ମଧ୍ୟଭାଗରେ, ଓଡ଼ି ଶାର ଶାସକ ଦଳ "ଦଳ ବି ରୋଧୀ କାର୍ଯ୍ୟ କଳାପ"
ଅଭି ଯୋଗରେ ବରି ଷ୍ଠ ନେତା ପ୍ର ଫୁ ଲ୍ଲ ମଲ୍ଲି କଙ୍କୁ  ନି ଲମ୍ବି ତ କରି ଥି ଲା । ସେ କେଉଁ  ଦଳର ବରି ଷ୍ଠ
ନେତା ଥି ଲେ?

A.  ଭାରତୀୟ ଜନତା ପାର୍ଟି (BJP)

B.  ବି ଜୁ  ଜନତା ଦଳ (BJD)

C.  ଭାରତୀୟ ଜାତୀୟ କଂଗ୍ରେ ସ (INC)

D.  କମ୍ୟୁ ନି ଷ୍ଟ ପାର୍ଟି ଅଫ ଇଣ୍ଡି ଆ (CPI) 

✓

Q27 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କାହାକୁ  ଏସି ଆର ସର୍ବ ବୃ ହତ ଲୁ ଣି ଆ ହ୍ର ଦ (Brackish water
lagoon) ଭାବରେ ସ୍ୱୀକୃ ତି  ଦି ଆଯାଇଛି ?

A.  ପୁ ଲି କାଟ ହ୍ର ଦ

B.  ଭେମ୍ବନାଡ ହ୍ର ଦ

C.  ଚି ଲି କା ହ୍ର ଦ

D.  କୋଲେରୁ  ହ୍ର ଦ

✓

Q28 GA
ଭେନେଜୁ ଏଲାରେ ଗଣତନ୍ତ୍ର ପ୍ର ତି ଷ୍ଠା ପାଇଁ  କାର୍ଯ୍ୟ  କରି  2025 ମସି ହା ଅକ୍ଟୋବର ମାସରେ
କେଉଁ  ବି ରୋଧୀ ଦଳର ନେତ୍ରୀ  ନୋବେଲ ଶାନ୍ତି  ପୁ ରସ୍କାର ପାଇଥି ଲେ?

A.  ଜୁ ଆନ ଗୁ ଆଇଡୋ (Juan Guaidó)

B.  ମାରି ଆ କୋରି ନା ମଚାଡୋ (María Corina Machado)

C.  ଲି ଓପୋଲଡୋ ଲୋପେଜ (Leopoldo López)

D.  ଗୁ ସ୍ତାଭୋ ପେଟ୍ରୋ (Gustavo Petro)

✓

Q29 GA
ଅମ୍ଳୀ ୟ ଜଳ ପଥରର ପୃ ଷ୍ଠଭାଗ ସହି ତ ପ୍ର ତି କ୍ରି  ୟା କରି ବା ଫଳରେ କେଉଁ  ପ୍ର କାରର ଅପକ୍ଷୟ
(Weathering) ସଂଘଟି ତ ହୋଇଥାଏ?

A.  ଯାନ୍ତ୍ରି କ ଅପକ୍ଷୟ

B.  ଜୈ ବି କ ଅପକ୍ଷୟ

C.  ଭୌତି କ ଅପକ୍ଷୟ

D.  ରାସାୟନି କ ଅପକ୍ଷୟ
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✓

Q30 GA
ଜଣେ ମତ୍ସ୍ୟଚାଷୀ ତାଙ୍କ ନି ଜ ପୋଖରୀରେ ମାଛ ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  କରି ବାକୁ  ଚାହାଁ ନ୍ତି  । ସେ
ଏକାଠି  ଭାକୁ ର, ରୋହି , ମି ରି କାଳୀ, କମନ୍  କାର୍ପ  , ଏବଂ ଗ୍ରା ସ କାର୍ପ  ମାଛ ଛାଡ଼ି ବାକୁ  ନି ଷ୍ପତ୍ତି
ନି ଅନ୍ତି  । ଗୋଟି ଏ ପୋଖରୀରେ ଏହି  ପ୍ର ଜାତି ଗୁ ଡ଼ି କର ମି ଶ୍ର ଣ ବ୍ୟବହାର କରି ବାର ମୁ ଖ୍ୟ
ଫାଇଦା କ’ଣ?

A.  ସେମାନେ ଭି ନ୍ନ ଭି ନ୍ନ ଅଞ୍ଚଳରେ ରହି ବା ଏବଂ ଭି ନ୍ନ ଭି ନ୍ନ ଖାଦ୍ୟାଭ୍ୟାସ ଗ୍ର ହଣ କରି ବା
ଦ୍ୱାରା ଉପଲବ୍ଧ ସମସ୍ତ ଖାଦ୍ୟ ସମ୍ବଳର ସଦୁ ପଯୋଗ କରି ଥାନ୍ତି  ।

B.  ସେମାନେ ସମାନ ହାରରେ ବୃ ଦ୍ଧି  ପାଆନ୍ତି  ଏବଂ ସେମାନଙ୍କର ସଦୃ ଶ ଯତ୍ନ ଆବଶ୍ୟକ
ହୁ ଏ । 

C.  ସେଗୁ ଡି କ ସବୁ  ସ୍ଥାନୀୟ ପ୍ର ଜାତି , ଯାହାକି  କେବଳ ଲୁ ଣି  ଜଳ ପାଇଁ  ଉପଯୁ କ୍ତ ଅଟେ ।

D.  ସେଗୁ ଡ଼ି କ ପୋଖରୀରେ ଜଳ ପରି ବର୍ତ୍ତ ନର ଆବଶ୍ୟକତାକୁ  ଏଡ଼ାଇଥାଏ ।

✓

Q31 GA
କାହିଁକି  ଶୀତ ଋତୁ ରେ ତାମି ଲନାଡୁ  ଉପକୂ ଳରେ ଅଧି କ ବର୍ଷା  ହୁ ଏ?

A.  ଏହା ଆରବ ସାଗରରୁ  ଜଳୀୟବାଷ୍ପ ବହନ କରି  ଆଣୁ ଥି ବା ଦକ୍ଷି ଣ-ପଶ୍ଚି ମ ମୌସୁ ମୀ
ବାୟୁ  ପ୍ର ବାହ ପଥରେ ଅବସ୍ଥି ତ ।

B.  ପଶ୍ଚି ମ ଲଘୁ ଚାପ ବି ଶୃ ଙ୍ଖଳା ଭୂ ମଧ୍ୟସାଗରୀୟ ଅଞ୍ଚଳରୁ  ପ୍ର ବଳ ବର୍ଷା  ଆଣି ଥାଏ ।

C.  ଉତ୍ତର-ପୂ ର୍ବ  ଆୟନ ବାୟୁ  ବଙ୍ଗୋପସାଗରରୁ  ଜଳୀୟବାଷ୍ପ ଆଣି  ବର୍ଷା  କରି ଥାଏ ।

D.  ସ୍ଥାନୀୟ ପରି ଚଳନ ସ୍ରୋ ତ ପ୍ର ବଳ ବୃ ଷ୍ଟି ପାତର କାରଣ ହୋଇଥାଏ ।

✓

Q32 GA
ଭାରତର ପଶ୍ଚି ମ ଉପକୂ ଳରେ ଅବସ୍ଥି ତ କୋଙ୍କଣ ଉପକୂ ଳ ମୁ ଖ୍ୟତଃ କେଉଁ  ରାଜ୍ୟ ସହି ତ
ଜଡ଼ି ତ?

A.  ଓଡି ଶା

B.  ପଶ୍ଚି ମବଙ୍ଗ

C.  ତାମି ଲନାଡୁ

D.  ମହାରାଷ୍ଟ୍ର

✓

Q33 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଭାରତରେ ସାମାଜି କ ଭି ତ୍ତି ଭୂ ମି ର ଏକ ଅଂଶ ଅଟେ?

A.  ରାଜପଥ ଓ ରେଳପଥ

B.  ବି ଦ୍ୟୁ ତ ଶକ୍ତି  କେନ୍ଦ୍ର

C.  ପରି ମଳ ଏବଂ ପାନୀୟ ଜଳ 

D.  ରପ୍ତାନୀ ଶି ଳ୍ପ

✓

Q34 GA
ପାରାଲି ମ୍ପି କ୍  କ୍ରୀ ଡ଼ାରେ ବ୍ୟକ୍ତି ଗତ ପଦକ ଜି ତି ଥି ବା ପ୍ର ଥମ ଭାରତୀୟ ମହି ଳା କି ଏ ଥି ଲେ?

A.  ଭାବି ନା ପଟେଲ

B.  ଦୀପା ମଲି କ 

C.  ଦେବେନ୍ଦ୍ର ଝାଝାରି ୟା

D.  ଅବନୀ ଲେଖରା

✓

Q35 GA
ଉତ୍କଳ ସମ୍ମି ଳନୀର ମୂ ଳଦୁ ଆ ପକାଇଥି ବା ପ୍ର ଥମ ଓଡ଼ି ଆ ଜାତୀୟ ସମ୍ମି ଳନୀ ଆୟୋଜନ
କରି ବାରେ କେଉଁ  ନେତାମାନଙ୍କ ମି ଳି ତ ସମାହାର ସି ଧାସଳଖ ଏବଂ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ
କରି ଥି ଲା?

A.  ଓଡ଼ି ଆ ଓକି ଲ, ୟୁ ରୋପୀୟ ଅଧି କାରୀ, ବି ଦ୍ୟାର୍ଥୀ  

B.  ଶ୍ୟାମ ସୁ ନ୍ଦର ରାଜଗୁ ରୁ , ରାଜ ବାଇକୁ ନ୍ଥା ନାଥ ଦେ, ଖଲି କୋଟର ରାଜା

C.  ମଧୁ ସୂ ଦନ ଦାସ, ରାଜେନ୍ଦ୍ରନାରାୟଣ ଭଞ୍ଜ ଦେଓ, ଶ୍ରୀ ରାମ ଚନ୍ଦ୍ର ଭଞ୍ଜଦେଓ

D.  ହେନେରୀ ରି ସଲେ, ଲର୍ଡ  କର୍ଜ ନ, ମୟୁ ରଭଞ୍ଜର ମହାରାଜା  

✓

Q36 GA
ଓଜୋନ ସ୍ତରକୁ  କ୍ଷୟ କରୁ ଥି ବା ପଦାର୍ଥ ଗୁ ଡ଼ି କ ସହ କେଉଁ  ପ୍ରୋ ଟୋକଲ ସମ୍ପୃ କ୍ତ ଅଟେ?

A.  କ୍ୟୋଟୋ ପ୍ରୋ ଟୋକଲ

B.  ମଣ୍ଟ୍ରି ଆଲ ପ୍ରୋ ଟୋକଲ

C.  ନାଗୋୟା ପ୍ରୋ ଟୋକଲ

D.  କାର୍ଟା ଜେନା ପ୍ରୋ ଟୋକଲ

✓

Q37 GA
କେଉଁ  ପଦକ୍ଷେପ ଉଭୟ କ୍ରୀ ଡା ଅଂଶଗ୍ର ହଣ ଏବଂ ଭି ତ୍ତି ଭୂ ମି  ବି କାଶ କୁ  ଗୁ ରୁ ତ୍ୱ ଦି ଏ?

A.  ଖେଲୋ ଇଣ୍ଡି ଆ ପ୍ରୋ ଗ୍ରା ମ

B.  ଫି ଟ ଇଣ୍ଡି ଆ ମୁ ଭମେଣ୍ଟ

C.  ନ୍ୟାସନାଲ ସ୍ପୋର୍ଟ୍ସ  ପଲି ଶି  

D.  ଟାର୍ଗେ ଟ ଅଲି ମ୍ପି କ ପୋଡି ୟମ ସ୍କି ମ 

✓

Q38 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ସଂଶୋଧନ ଅଧୀନରେ 'ସି ନ୍ଧୀ' ଭାଷାକୁ  ଅଷ୍ଟମ ଅନୁ ସୂ ଚୀରେ ଅନ୍ତର୍ଭୁ କ୍ତ
କରାଯାଇଥି ଲା?

A.  ଏକୋଇଶି  ତମ ସଂଶୋଧନ ଅଧି ନି ୟମ

B.  ଏକତି ରି ଶ ତମ ସଂଶୋଧନ ଅଧି ନି ୟମ

C.  ଏକଚାଳି ଶ ତମ ସଂଶୋଧନ ଅଧି ନି ୟମ

D.  ଏକାବନ ତମ ସଂଶୋଧନ ଅଧି ନି ୟମ
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✓

Q39 GA
1897 ମସି ହାରେ ମରାଠୀ ଭାଷା ଖବରକାଗଜ କେଶରୀ ରେ ବ୍ରି  ଟି ଶମାନଙ୍କୁ  ସମାଲୋଚନା
କରି ବା ଅଭି ଯୋଗରେ ନି ମ୍ନ ଲି ଖି ତମାନଙ୍କ ମଧ୍ୟରୁ  କାହା ବି ରୋଧରେ ଧାରା 124A
ଲଗାଯାଇଥି ଲା?

A.  ଧୋଣ୍ଡୋ କେଶବ କର୍ଭେ

B.  ବି ନାୟକ ଦାମୋଦର ସାବରକର 

C.  B.R. ଆମ୍ବେଦକର 

D.  ବାଲ ଗଙ୍ଗାଧର ତି ଳକ 

✓

Q40 GA
ଜୁ ନ 2025 ରେ ଷ୍ଟାଭେଙ୍ଗରଠାରେ ଅନୁ ଷ୍ଠି ତ 2025 ନରୱେ ଚେସ ଟୁ ର୍ଣ୍ଣା ମେଣ୍ଟରେ
ଗ୍ରା ଣ୍ଡମାଷ୍ଟର ଡି  ଗୁ କେଶ କେଉଁ  ବି ଶ୍ୱପ୍ର ସି ଦ୍ଧ ଚେସ କି ମ୍ବଦନ୍ତୀଙ୍କ ବି ରୁ ଦ୍ଧରେ ନି ଜର ପ୍ର ଥମ
ଉତ୍କୃ ଷ୍ଟ ବି ଜୟ ହାସଲ କରି ଥି ଲେ?

A.  ଫାବି ଆନୋ କାରୁ ଆନା (Fabiano Caruana)

B.  ମାଗ୍ନସ କାର୍ଲ ସେନ (Magnus Carlsen)

C.  ହି କାରୁ  ନାକାମୁ ରା (Hikaru Nakamura) 

D.  ୱେସଲୀ ସୋ (Wesley So)

English

✓

Q41 English
Complete the sentence with the appropriate preposition.

He is known ____ his expertise in ancient history.1445

A.  by

B.  for

C.  of

D.  with

✓

Q42 English
Select the most appropriate meaning of the given word.

Thearchy

A.  A political system based on the government of men

B.  A political system based on the government of men by God

C.  A religious system based on the government of men by God

D.  A religious system based on the government of men
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✓

Q43 English
Select the most appropriate option that rectifies the incorrectly spelt word in the given sentence.

The audience was full of enthusism.

A.  enthusiasem

B.  enthuseasm

C.  enthisiasm

D.  enthusiasm

✓

Q44 English
Select the option that can be used as a one-word substitute for the given phrase.

A state of being extremely dry or barren, incapable of supporting vegetation

A.  Verdancy

B.  Aridity

C.  Luxuriance

D.  Fertility

✓

Q45 English
Replace the highlighted segment with an appropriate idiom.
He refused to apologize and continued to argue without reason.

A.  split hairs

B.  break the ice

C.  call it a day

D.  spill the beans

✓

Q46 English
Identify the antonym for the given in bold:
Despite earning a large salary, my brother is very frugal at gifting.

A.  spendthrift

B.  stingy

C.  meticlulous

D.  economical

✓

Q47 English
Complete the sentence by choosing the correct option:
She .............. for two hours when I called her yesterday.

A.  studied

B.  was studying

C.  had studied

D.  had been studying
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✓

Q48 English
Choose the most appropriate idiom to substitute the underlined segment in the given sentence.

Riya had been avoiding the truth for months, but yesterday she finally accepted reality

A.  beat around the bush

B.  came to terms with it

C.  jumped the gun

D.  drew the line

✓

Q49 English

Choose the correct direct form from the given options.

The guard asked why we had entered the restricted area.

A.  The guard asked, “Why had you been entered the restricted area?”

B.  The guard asked, “Why have been you entered the restricted area?”

C.  The guard asked, “Why did you enter the restricted area?”

D.  The guard asked, “Why are you entering the restricted area?”

✓

Q50 English
Choose the incorrect passive form.

A.  The vaccination drive is being conducted across rural districts.

B.  Thousands of doses were distributed during the campaign.

C.  The campaign was being promoted through community meetings.

D.  The vaccines have distribute to high-risk groups.

✓

Q51 English
Complete the sentence by selecting the appropriate option.
The speaker addressed the audience ______ and responded to their questions ______, ensuring complete clarity throughout the session.

A.  hesitantly, vaguely

B.  confidently, precisely

C.  nervously, randomly

D.  abruptly, carelessly

✓

Q52 English
Select the most appropriate ANTONYM of the highlighted word.

The instructions for the experiment were precise and easy to follow.

A.  specific

B.  typical

C.  accurate

D.  vague
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✓

Q53 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. fuels and support
B. sustainable development
C. sources reduce
D. using renewable energy
E. dependence on fossil

A.  ACBDE

B.  CDBAE

C.  DCEAB

D.  EDACB

✓

Q54 English

Read the passage carefully and answer the questions that follow.

One aspect of the history of catastrophe markets is very old. Weather gambling was described by one newspaper in 1931 as ‘one of the oldest,
most fascinating and uncertain gambles in the world’. In 1886, betting on how long it would rain was in fashion, and, by the 1930s, office weather
pools were commonplace. Weather gambling has now taken organised forms from the 19th to the 21st centuries, from informal bets to
gambling rings and lotteries. Rain betting, the oldest and most common form of weather gambling, was often tied to local community traditions.
It flourished in Calcutta and Bombay in the 1880s and ’90s. Crowds gathered to gamble on whether a rain gauge would overflow, confident that
cheating was impossible because there was no ambiguity in a downpour. As one newspaper remarked: ‘When it rains in India it rains; there is no
half-way business about it.’

Choose the most appropriate title for the passage.

A.  The Role of Newspapers in Reporting Local Traditions

B.  The Impact of Rainfall on Indian Agricultural Practices

C.  The Development of Modern Gambling Industries Worldwide

D.  The Evolution of Weather Gambling Across Different Periods

✓

Q55 English
Which of the following is a fact stated in the passage?

A.  Weather gambling began only in the twentieth century

B.  Rain betting was popular in Calcutta and Bombay

C.  Gambling on weather was banned in all Indian cities

D.  Rainfall was considered difficult to measure accurately

✓

Q56 English
Why did people believe cheating was impossible in rain betting?

A.  The betting was strictly regulated by official authorities

B.  Rainfall could be measured clearly without any confusion

C.  Only trained experts were allowed to participate in betting

D.  The results were announced publicly by newspapers daily
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✓

Q57 English
Which of the following best summarises the passage?

A.  An overview of weather gambling and its growth

B.  A description of rainfall patterns in Indian cities

C.  A discussion on laws regulating gambling activities

D.  A comparison of different forms of betting practices

✓

Q58 English
Choose the antonym of the word ‘flourished’ as used in the passage.

A.  Prospered

B.  Thrived

C.  Declined

D.  Dismantled

✓

Q59 English
Select the most appropriate articles to fill in the blanks. If no article is required, select ‘No article required’.

India is one of ___ very big countries in ___ world.

A.  a; the

B.  an; a

C.  the; the

D.  the; a

✓

Q60 English
Parts of a sentence are given below. While the first and the last parts (P1 and P6) are in the correct order, the remaining parts (labelled A, B, C
and D) are jumbled up. Arrange the parts in the correct order to form a meaningful and coherent sentence.

P1. With a mischievous glint
A. explorer strapped on her backpack,
B. in her eye, the adventurous
C. promised discovery, challenge,
D. ready to embark on a journey that
P6. and the thrill of the unknown

A.  BACD

B.  ABCD

C.  BADC

D.  CBAD
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କ୍ୟାବି ନେଟ ଦେଶର ପ୍ର ଶାସନି କ ବ୍ୟବସ୍ଥା ଚଳାଇଥାଏ ।

A.  The cabinet runs the administration of the country.

B.  The cabinet run administration country.

C.  Cabinet is running of administration.

D.  The cabinet are runs the country.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The Brahmaputra flows through India, Bangladesh, and China.

A.  ବ୍ର ହ୍ମପୁ ତ୍ର  ନଦୀ ଚୀନ, ଭାରତ ଏବଂ ବାଂଲାଦେଶ ଦେଇ ପ୍ର ଭାବି ତ ହେଉଛି ।

B.  ବ୍ର ହ୍ମପୁ ତ୍ର  ଭାରତ, ବାଙ୍ଗ୍ଲାଦେଶ ଓ ଚି ନ ମାଧ୍ୟରେ ପ୍ର ବାହ ହୁ ଏ।

C.  ବ୍ର ହ୍ମପୁ ତ୍ର  ଭାରତ, ବାଙ୍ଗ୍ଲାଦେଶ ଓ ଚି ନ ମାଧ୍ୟମେ ପ୍ର ବାହି ତ ହୁ ଏ।

D.  ବ୍ର ହ୍ମପୁ ତ୍ର  ଭାରତ, ବାଙ୍ଗ୍ଲାଦେଶ ଚି ନ ମାଧ୍ୟରେ ପ୍ର ବାହି ତ ହୁ ଏ।

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଆମ ବଗି ଚା ଖୁ ବ ସୁ ନ୍ଦର ହୋଇଯାଇଛି  ।

A.  Our garden is very beautiful.

B.  Our garden has become very beautiful.

C.  Our garden was very beautiful.

D.  Our garden is becoming very beautiful.
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✓

Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

ଆଗାମୀ ବର୍ଷ  ଗୁ ଡ଼ି କରେ ଭାରତ 5 ଟ୍ରି  ଲି ୟନ ଡଲାର ଅର୍ଥ ନୀତି  ହେବାକୁ  ଲକ୍ଷ୍ୟ ରଖି ଛି , ଯାହା ବି ଶ୍ୱର ପ୍ର ମୁ ଖ ଅର୍ଥ ନୀତି  ମଧ୍ୟରୁ  ଗୋଟି ଏ ଭାବରେ ନି ଜର ସ୍ଥି ତି କୁ  ଆହୁ ରି  ମଜବୁ ତ ​​କରି ବା ପାଇଁ  ଏକ
ମହତ୍ୱାକାଂକ୍ଷୀ ଲକ୍ଷ୍ୟ। ଏହି  ଦୃ ଷ୍ଟି କୋଣ ବି ଷୟରେ ପ୍ର ଥମେ ପ୍ର ଧାନମନ୍ତ୍ରୀ ନରେନ୍ଦ୍ର ମୋଦୀ 2019 ରେ ଘୋଷଣା କରି  କହି ଥି ଲେ ଯେ ଭାରତ ଏହି  ଲକ୍ଷ୍ୟକୁ  2024-25 ସୁ ଦ୍ଧା ହାସଲ କରି ବ। ଏହି
ଉଦ୍ଦେଶ୍ୟ ଭାରତର ଆର୍ଥିକ ଅଭି ବୃ ଦ୍ଧି କୁ  ବୃ ଦ୍ଧି  କରି ବା, ନି ଯୁ କ୍ତି  ସୁ ଯୋଗ ସୃ ଷ୍ଟି  କରି ବା ଏବଂ ନାଗରି କଙ୍କ ଜୀବନଧାରଣ ମାନରେ ଆହୁ ରି  ଉନ୍ନତ କରି ବା ପାଇଁ  ଆଶା ଓ ଆକାଂକ୍ଷାକୁ  ଦର୍ଶା ଇଥାଏ । ଏହି
ଲକ୍ଷ୍ୟ ହାସଲ କରି ବା ପାଇଁ , ଭାରତ ସରକାର ଉତ୍ପାଦନ, ଭି ତ୍ତି ଭୂ ମି , କୃ ଷି , ସେବା ଏବଂ ଡି ଜି ଟାଲ ନବସୃ ଜନ ଭଳି  ପ୍ର ମୁ ଖ କ୍ଷେତ୍ର  ଉପରେ ପ୍ରା ଧାନ୍ୟ ଦେଇଛନ୍ତି  ଏବଂ ଏହି  କ୍ଷେତ୍ର ରେ ଅନେକ ପଦକ୍ଷେପ
ମାନ ଗ୍ର ହଣ କରି ଛନ୍ତି  ।

ମେକ୍  ଇନ୍  ଇଣ୍ଡି ଆ ଏବଂ ଡି ଜି ଟାଲ ଇଣ୍ଡି ଆ ପଦକ୍ଷେପ ଶି ଳ୍ପ ଅଭି ବୃ ଦ୍ଧି  ଏବଂ ପ୍ର ଯୁ କ୍ତି  ବି ଦ୍ୟା ପ୍ରୋ ତ୍ସାହନରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରି ଛି  । ସ୍ଥାୟୀ ଏବଂ ଅନ୍ତର୍ଭୁ କ୍ତି ମୂ ଳକ ଅଭି ବୃ ଦ୍ଧି  ସୁ ନି ଶ୍ଚି ତ କରି ବା
ପାଇଁ  ଆମ ଦେଶ ନବୀକରଣୀୟ ଶକ୍ତି , ପରି ବହନ ନେଟୱାର୍କ  ଏବଂ ଦକ୍ଷତା ବି କାଶ କ୍ଷେତ୍ର ରେ ମଧ୍ୟ ନି ବେଶ କରୁ ଛି । କୋଭି ଡ୍ -19 ମହାମାରୀ ଅସ୍ଥାୟୀ ଭାବରେ ଭାରତର ଅର୍ଥ ନୈ ତି କ ପ୍ର ଗତି କୁ
ମନ୍ଥର କରି ଦେଇଥି ଲା, କି ନ୍ତୁ ବର୍ଦ୍ଧିତ ଘରୋଇ ଚାହି ଦା, ଡି ଜି ଟାଲ ପରି ବର୍ତ୍ତ ନ ଏବଂ କର ଏବଂ ବି ଦେଶୀ ନି ବେଶରେ ସଂସ୍କାର ମାଧ୍ୟମରେ ଅର୍ଥ ନୀତି ର ଦୃ ଢ଼ ପୁ ନରୁ ଦ୍ଧାର ହୋଇଛି  ।

5 ଟ୍ରି  ଲି ୟନ ଡଲାର ଲକ୍ଷ୍ୟ ହାସଲ କରି ବା ପାଇଁ  ବାର୍ଷିକ ହାରାହାରି  GDP ଅଭି ବୃ ଦ୍ଧି  ହାର ପ୍ରା ୟ 8-9% ଆବଶ୍ୟକ। ସରକାର ଉଦ୍ୟୋଗୀତାକୁ  ପ୍ରୋ ତ୍ସାହି ତ କରି ବା, ବ୍ୟବସାୟ କରି ବାର ସହଜତାକୁ
ଉନ୍ନତ କରି ବା ଏବଂ ବି ଶ୍ୱ ନି ବେଶକଙ୍କୁ  ଆକର୍ଷିତ କରି ବା ଜାରି  ରଖି ଛନ୍ତି । ଅର୍ଥ ନୀତି ଜ୍ଞ ମାନେ ବି ଶ୍ୱାସ କରନ୍ତି  ଯେ ଏହାର ଯୁ ବ ଜନସଂଖ୍ୟା, ବର୍ଦ୍ଧିତ ମଧ୍ୟବି ତ୍ତ ଶ୍ରେ ଣୀ ଏବଂ ଦ୍ରୁ ତ ସହରୀକରଣ ସହି ତ,
ଭାରତ ନି କଟ ଭବି ଷ୍ୟତରେ ଏହି  ଲକ୍ଷ୍ୟ ପୂ ରଣ କରି ବାର ସମ୍ଭାବନା ରଖି ଛି । 5 ଟ୍ରି  ଲି ୟନ ଡଲାର ଅର୍ଥ ନୀତି  ହାସଲ କରି ବା ଦ୍ୱାରା କେବଳ ଭାରତର ବି ଶ୍ୱ ପଟଳ ରେ ସ୍ଥି ତି  ବୃ ଦ୍ଧି  ହେବ ନାହିଁ ବରଂ
ଦାରି ଦ୍ର୍ୟ  ହ୍ରା ସ ଏବଂ ସାମଗ୍ରି  କ ଜାତୀୟ ସମୃ ଦ୍ଧି ରେ ମଧ୍ୟ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଯୋଗଦାନ ମି ଳି ବ। ଏହି  ଲକ୍ଷ୍ୟ ହାସଲ ହେଲେ ଦେଶର ଅଗଣି ତ ଲୋକଙ୍କ ହି ତସାଧନ ହେବ ବୋଲି  କହି ଲେ ଅତ୍ଯୁ କ୍ତି  ହେବ
ନାହିଁ |

ଭାରତର 5 ଟ୍ରି  ଲି ୟନ ଡଲାର ଅର୍ଥ ନୀତି  ହେବାର ଲକ୍ଷ୍ୟ ପ୍ର ଥମେ କି ଏ ଘୋଷଣା କରି ଥି ଲେ?

A.  ଡକ୍ଟର ମନମୋହନ ସିଂ ହ

B.  ନରେନ୍ଦ୍ର ମୋଦି

C.  ନି ର୍ମ ଳା ସୀତାରମଣ

D.  ରଘୁ ରାମ ରାଜନ

✓

Q65 Odia
କେଉଁ  ବର୍ଷ  ସୁ ଦ୍ଧା ଭାରତ 5 ଟ୍ରି  ଲି ୟନ ଡଲାର ଲକ୍ଷ୍ୟ ହାସଲ କରି ବ ବୋଲି  ଆଶା କରାଯାଇଥି ଲା?

A.  2020-21

B.  2022 -23

C.  2024 -25

D.  2026 -27

✓

Q66 Odia
କେଉଁ  ପଦକ୍ଷେପ ଭାରତରେ ଶି ଳ୍ପ ଅଭି ବୃ ଦ୍ଧି କୁ  ପ୍ରୋ ତ୍ସାହି ତ କରେ?

A.  ସ୍ୱଚ୍ଛ ଭାରତ

B.  ମେକ୍  ଇନ୍  ଇଣ୍ଡି ଆ

C.  ବେଟି  ବଚାଓ ବେଟି  ପଢ଼ାଓ

D.  ସ୍କି ଲ୍  ଇଣ୍ଡି ଆ

✓

Q67 Odia
ଲକ୍ଷ୍ୟ ହାସଲ କରି ବା ପାଇଁ  ବାର୍ଷିକ ହାରାହାରି  GDP ଅଭି ବୃ ଦ୍ଧି  ହାର କେତେ ଆବଶ୍ୟକ?

A.  4 –5 %

B.  6 –7 %

C.  8 –9 %

D.  10 –12 %
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✓

Q68 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ଶବ୍ଦଗୁ ଡ଼ି କୁ  ସେମାନଙ୍କର ଅର୍ଥ  ସହି ତ ମେଳ କରନ୍ତୁ:
1. ମହତ୍ୱାକାଂକ୍ଷୀ A

.
ଆଇନ ଏବଂ ବ୍ୟବସ୍ଥାରେ ବି କାଶ କି ମ୍ବା ଉନ୍ନତି

2. ଅନ୍ତର୍ଭୁ କ୍ତ B
.
ସହରଗୁ ଡ଼ି କୁ  ବୃ ଦ୍ଧି  କରି ବାର ପ୍ର କ୍ରି  ୟା

3. ସଂସ୍କାର C
.
କି ଛି  ମହାନ ହାସଲ କରି ବା ଲକ୍ଷ୍ୟରେ

4. ସହରୀକରଣ D
.
ସମସ୍ତଙ୍କୁ  ସମାନ ଭାବରେ ସାମି ଲ କରି ବା

A.  1-C, 2-D, 3-A, 4-B

B.  1-B, 2-D, 3-A, 4-C

C.  1-C, 2-A, 3-D, 4-B

D.  1-D, 2-C, 3-A, 4-B

✓

Q69 Odia
ଗାଆଁ ର ଜଣେ ବ୍ୟକ୍ତି  ଭାଗବତ ପଢୁ ଛନ୍ତି  । ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  କ୍ରି  ୟାପଦ?

A.  ଅକର୍ମ କ କ୍ରି  ୟା

B.  ସକର୍ମ କ କ୍ରି  ୟା

C.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

D.  ଧ୍ଵନ୍ୟାତ୍ମକ କ୍ରି  ୟା

✓

Q70 Odia
"ଶି ଆଳ ବୈ ଷ୍ଣବ ହେବା" ଏହି  ଲୋକୋକ୍ତି ଟି  କେଉଁ  ପରି ପ୍ରେ କ୍ଷୀରେ ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  ଶି ଆଳ ମାଂସ ଖାଇବା ଛାଡ଼ି ବା

B.  ଖଳ ଲୋକ ସାଧୁ ର ବେଶ ଧରି ବା

C.  ପଶୁ ମାନଙ୍କର ସ୍ୱଭାବ ବଦଳି ବା

D.  ଭକ୍ତି  ମନୋଭାବ ରଖି ବା

✓

Q71 Odia
“ମାରି ନେଲେ ମହାପାତ୍ରେ , ଚାହିଁଥା’ରେ ଜଳକା” ଲୋକବାଣୀର ଅର୍ଥ  କ’ଣ?

A.  ଦୁ ର୍ବ ଳ ଲୋକ ହାରି ଯାଏ ।

B.  ସବୁ ଠି  ସମାନ ସୁ ଯୋଗ ମି ଳେ ।

C.  ଚତୁ ର ଲୋକ ସୁ ବି ଧା ହାସଲ କଲାବେଳେ, ବୋକାଲୋକ ନି ରାଶ ହୁ ଏ ବା ଅପଦସ୍ଥ ହୁ ଏ ।

D.  ଶକ୍ତି ଶାଳୀ ଲୋକ ହିଁ ଜି ତେ ।

✓

Q72 Odia
ତଦ୍ଭବ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  ନଈ

B.  ନକୁ ଳ

C.  ମୃ ଗ

D.  ଷଷ୍ଠୀ
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✓

Q73 Odia
"ରାମ ଓ ଲକ୍ଷ୍ମଣ ବନକୁ  ଗଲେ" - ଏଠାରେ 'ଓ' କି  ପ୍ର କାର ଅବ୍ୟୟ?

A.  ବି ଭକ୍ତି ସୂ ଚକ ଅବ୍ୟୟ

B.  ସଂଯୋଜକ ଅବ୍ୟୟ

C.  ବି ୟୋଜକ ଅବ୍ୟୟ

D.  ପଦାନ୍ୱ ୟୀ ଅବ୍ୟୟ

✓

Q74 Odia
ସବୁ  କଥାରେ ଆଖେଇବା ଉଚି ତ ନୁ ହେଁ  । ଏହି  ବାକ୍ୟରେ 'ଆଖେଇବା' କେଉଁ  ପ୍ର କାରର କ୍ରି  ୟା?

A.  ସକର୍ମ କ କ୍ରି  ୟା

B.  ଅକର୍ମ କ କ୍ରି  ୟା

C.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

D.  ଅବ୍ୟୟ

✓

Q75 Odia
"ମୁ ହଁ  ଦେବା" ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କ'ଣ ?

A.  ମୁଁ ହ ଡେଖାଇବା

B.  କାହାକୁ  ଡାକି ବା

C.  ପ୍ର ଶୟ ଦେବା

D.  କଥା କହି ବା

Computer

✓

Q76 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ସି ଷ୍ଟମ ସଫ୍ଟ ୱେରର ଏକ ଉଦାହରଣ ଅଟେ ଯାହା ସି ଧାସଳଖ କମ୍ପ୍ୟୁ ଟର
ହାର୍ଡ ୱେର ମ୍ୟାନେଜ କରେ ଏବଂ ଆପ୍ଲି  କେସନ ସଫ୍ଟ ୱେର ପାଇଁ  ଏକ ପ୍ଲା ଟଫର୍ମ  ପ୍ର ଦାନ
କରେ?

A.  ମାଇକ୍ରୋ ସଫ୍ଟ  ୱାର୍ଡ

B.  ଏଡୋବି  ଫଟୋସପ

C.  ଅପରେଟିଂ  ସି ଷ୍ଟମ

D.  ଗୁ ଗଲ କ୍ରୋ ମ

✓

Q77 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ସେଣ୍ଟ୍ରାଲ ପ୍ରୋ ସେସି ଙ୍ଗ ୟୁ ନି ଟ (CPU) ର ପ୍ରା ଥମି କ କାର୍ଯ୍ୟ  ଅଟେ?

A.  ଡାଟା ପ୍ରୋ ସେସିଂ  କରି ବା

B.  ଫାଇଲ ଷ୍ଟୋର କରି ବା

C.  ଗ୍ରା ଫି କ୍ସ ଡି ସପ୍ଲେ  କରି ବା

D.  ଅଡି ଓ ପ୍ଲେ  କରି ବା

✓

Q78 Computer
ପ୍ର ଥମ ଥର ପାଇଁ  MS ପାୱାରପଏଣ୍ଟରେ ଏକ ନୂ ତନ ପ୍ରେ ଜେଣ୍ଟେସନ ସେଭ କରି ବା ପାଇଁ
ଆପଣ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ପଦକ୍ଷେପ ବ୍ୟବହାର କରି ବେ?

A.  Insert > Save

B.  View > Save As

C.  File > Save As

D.  Design > Save

✓

Q79 Computer
MS ୱାର୍ଡ ରେ କେଉଁ  ମେନୁ  ଆପଣଙ୍କୁ  ଲି ଷ୍ଟରେ ବୁ ଲେଟ କି ମ୍ବା ନମ୍ବରିଂ  ଆଡ କରି ବାକୁ  ଅନୁ ମତି
ଦି ଏ?

A.  Home tab

B.  Insert tab

C.  Design tab

D.  Layout tab
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✓

Q80 Computer
MS ୱାର୍ଡ  2021 ର Home ଟ୍ୟାବର କେଉଁ  ଗୃ ପ ଫଣ୍ଟ ଟାଇପ ଏବଂ ସାଇଜ ପରି ବର୍ତ୍ତ ନ
କରି ବାରେ ସାହାଯ୍ୟ କରେ?

A.  Insert Group

B.  Font Group

C.  Page Layout Group

D.  Styles Group

✓

Q81 Computer
ଯେତେବେଳେ ଆପଣ MS ୱାର୍ଡ ରେ Cut (Ctrl + X) କମାଣ୍ଡ ବ୍ୟବହାର କରନ୍ତି ,
ସେତେବେଳେ ରି ମୁ ଭ ହୋଇଥି ବା ଟେକ୍ସଟ ଟେମ୍ପୋରାରୀ ଭାବରେ କେଉଁ ଠାରେ ଷ୍ଟୋର
ହୋଇଥାଏ?

A.  କ୍ଲି  ପବୋର୍ଡ

B.  ସି ଷ୍ଟମ କ୍ୟାଶ

C.  ଡ୍ରା ଫ୍ଟ  ଫୋଲଡର

D.  ମେମୋରୀ ଫାଇଲ

✓

Q82 Computer
ଏକ ସ୍ପ୍ରେଡସି ଟର କେବଳ ଏକ ସ୍ପେସି ଫି କ ସେକ୍ସନ ପ୍ରି  ଣ୍ଟ କରି ବା ପାଇଁ  ଆପଣଙ୍କୁ  କ'ଣ
କରି ବାକୁ  ପଡି ବ?

A.  ପ୍ର ଥମେ ସେଲ ସି ଲେକ୍ଟ କରନ୍ତୁ, ତା'ପରେ ପ୍ରି  ଣ୍ଟ (Print) ଚୟନ କରନ୍ତୁ → ପ୍ରି  ଣ୍ଟ
(Print) ଚୟନ କରନ୍ତୁ

B.  ସମ୍ପୂ ର୍ଣ୍ଣ  ୱାର୍କ ସି ଟ ପ୍ରି  ଣ୍ଟ କରନ୍ତୁ

C.  ସେଭ ଏବଂ ତା'ପରେ ପ୍ରି  ଣ୍ଟ କରନ୍ତୁ

D.  ଫାଇଲ → ସେଭ ଆଜ

✓

Q83 Computer
ଇଣ୍ଟରନେଟ ମାଧ୍ୟମରେ ରି ଅଲ-ଟାଇମ ଟେକ୍ସଟ କମୁ ନି କେସନ ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ
କେଉଁ ଟି  ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  Email

B.  Instant Messaging

C.  File Transfer

D.  Mail Merge

✓

Q84 Computer
ଏକ ଇମେଲରେ ଲାର୍ଜ  ଫାଇଲ ଆଟାଚ କରି ବା ପୂ ର୍ବ ରୁ  କ'ଣ କରି ବା ଆବଶ୍ୟକ?

A.  ଫାଇଲ ସାଇଜ ଲି ମି ଟକୁ  ଇଗନୋର କରନ୍ତୁ

B.  ଫାଇଲକୁ  କମ୍ପ୍ରେସ କରନ୍ତୁ କି ମ୍ବା କ୍ଲା ଉଡ ଲି ଙ୍କ ବ୍ୟବହାର କରନ୍ତୁ

C.  ଏହାକୁ  ଅନାବଶ୍ୟକ ମଲ୍ଟି  ପୁ ଲ ଇମେଲରେ ପଠାନ୍ତୁ

D.  ଭାଇରସ ଚେକ ନକରି  ଆଟାଚ କରି ବା

✓

Q85 Computer
ମାଇକ୍ରୋ ସଫ୍ଟ  ପାୱାରପଏଣ୍ଟ 2021 ରେ କେଉଁ  ଫି ଚର ଅଛି  ଯାହା ଅଟୋମେଟି କ ଭାବେ
ସ୍ଲା ଇଡ ଡି ଜାଇନକୁ  ପରାମର୍ଶ  (suggests) ଦେଇଥାଏ?

A.  PowerPoint Designer

B.  Themes

C.  Slide Master

D.  Transitions

✓

Q86 Computer
ୱି ଣ୍ଡୋଜ 11 ରେ ପାୱାର ସେଭିଂ  ମୋଡ ଚୟନ କରି ବାର ମୁ ଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ କ'ଣ?

A.  ଡେସ୍କଟପ ଏଲି ମେଣ୍ଟ ନି ୟନ୍ତ୍ରଣ କରି ବା

B.  ବ୍ୟାଟେରୀ ବ୍ୟବହାର ଏବଂ ସି ଷ୍ଟମ କାର୍ଯ୍ୟ ଦକ୍ଷତା ଅଗ୍ରା ଧି କାରକୁ  ନି ୟନ୍ତ୍ରଣ କରି ବା
(To control battery usage and system performance preference)

C.  ଅବ୍ୟବହୃ ତ ଆପ୍ଲି  କେସନଗୁ ଡ଼ି କୁ  ଅନଇନଷ୍ଟଲ କରି ବା

D.  ଏକ ସି ଷ୍ଟମର ପାୱାର ବୃ ଦ୍ଧି  କରି ବା

✓

Q87 Computer
ଗ୍ରା ଫି କ୍ସ, ଅଡି ଓ ଏବଂ ଭି ଡି ଓ ସହି ତ ପ୍ରେ ଜେଣ୍ଟେସନ ତି ଆରି  କରି ବା ପାଇଁ  କେଉଁ  ସଫ୍ଟ ୱେୟାର
ବ୍ୟବହୃ ତ ହୁ ଏ?

A.  MS ୱାର୍ଡ଼

B.  MS ଏକ୍ସେଲ

C.  MS ପାୱାରପଏଣ୍ଟ

D.  MS ଆକସେସ

✓

Q88 Computer
MS ଏକ୍ସେଲର ଏକ ସେଲ (Cell) ରେ "25/12/2025" ଏଣ୍ଟର କଲେ କ'ଣ ହୋଇଥାଏ?

A.  ଏହାକୁ  ଏକ ଷ୍ଟ୍ରି ଙ୍ଗ ଭାବରେ ବି ବେଚନା କରାଯାଏ (It is treated as a string)

B.  ଏହା ଅଟୋମେଟି କ ଏକ ଡେଟ ଫର୍ମା ଟରେ କନଭର୍ଟ  ହୁ ଏ (It is automatically
converted to a date format)

C.  ଏହା ଏକ ସି ନଟାକ୍ସ ଏରର ସୃ ଷ୍ଟି  କରି ବ (It will generate a syntax error)

D.  ଏହା ଏକ ଟାଇମ ଭାଲ୍ୟୁ  ଭାବରେ ଡି ସପ୍ଲେ  ହେବ (It will be displayed as a
time value.)
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✓

Q89 Computer
କେଉଁ ଟି  ଆପଣଙ୍କ ୱି ଣ୍ଡୋଜ କମ୍ପ୍ୟୁ ଟରରେ MS ଏକ୍ସେଲକୁ  ପ୍ର ଭାବଶାଳୀ ଭାବରେ ଓପନ
କରି ବାର ପ୍ର ଥମ ଷ୍ଟେପ ଅଟେ?

A.  Start Menu → Search for Excel

B.  Right-click on desktop → Open

C.  Use Task Manager → Run Excel

D.  Press Ctrl + Alt + Del → Open

✓

Q90 Computer
MS ପାୱାରପଏଣ୍ଟ ରେ ଆପଣ ଟେମ୍ପଲେଟ କେଉଁ ଠାରେ ପାଇବେ?

A.  ହୋମ > ଟେମ୍ପଲେଟ

B.  ଫାଇଲ > ନି ୟୁ  > ଟେମ୍ପଲେଟ

C.  ଇନସର୍ଟ  > ଟେମ୍ପଲେଟ

D.  ଭି ୟୁ  > ଟେମ୍ପଲେଟ

Reasoning

✓

Q91 Reasoning
P, Q, R, S, T, U ଏବଂ V ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପାଖରେ କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ବସି ଛନ୍ତି
। V ଏବଂ U ର ନି କଟତମ ପଡ଼ୋଶୀ Q ଅଟେ । U ର ଠି କ ବାମ ପାର୍ଶ୍ଵ ରେ P ଅଛି  । P ଏବଂ S
ର ନି କଟତମ ପଡ଼ୋଶୀ T ନୁ ହେଁ  । R ର ଠି କ ଡାହାଣ ପାର୍ଶ୍ଵ ରେ କି ଏ ଅଛି ?

A.  T

B.  P

C.  V

D.  S

✓

Q92 Reasoning
A ର ବାପା B ର ଭାଇ ଏବଂ ଏକମାତ୍ର  ଭାଇ ଅଟନ୍ତି  । B V ର ପୁ ଅ ଅଟେ । V ର ଭାଇର ସ୍ତ୍ରୀ K
ଅଟେ । K ର ସ୍ୱାମୀଙ୍କର କେବଳ ଗୋଟି ଏ ଭଉଣୀ ଅଛନ୍ତି  ଏବଂ କୌଣସି  ଭାଇ ନାହାଁ ନ୍ତି  । B
ସମ୍ପର୍କ ରେ K ଙ୍କର କ'ଣ ହେବେ?

A.  ମାଆ

B.  ସ୍ତ୍ରୀଙ୍କ ମାଆଙ୍କ ଭଉଣୀ

C.  ସ୍ୱାମୀଙ୍କ ଭାଇଙ୍କ ପୁ ଅ

D.  ସ୍ୱାମୀଙ୍କ ଭଉଣୀଙ୍କ ପୁ ଅ

✓

Q93 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ BUNK ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ LEXU ସହି ତ
ସମ୍ପର୍କିତ । PIBY ସେହି  ସମାନ ଉପାୟରେ ZSLI ସହି ତ ସମ୍ପର୍କିତ । ସମାନ ତର୍କ
ଅନୁ ସରଣ କରି  ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସହି ତ TMFC ସମ୍ପର୍କିତ ହେବ ?

A.  DWPM

B.  DMPO

C.  DWER

D.  DMJU

✓

Q94 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର-ସଂଖ୍ୟା ପୁ ଞ୍ଜ
ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?

GLQ 33, EQV 42, CVA 51, AAF 60, ?

A.  YFK 69

B.  ZEL 67

C.  XGJ 69

D.  ZGK 67

✓

Q95 Reasoning
ଯଦି  + ର ଅର୍ଥ  −, − ର ଅର୍ଥ  ×, × ର ଅର୍ଥ  ÷, ÷ ଅର୍ଥ  + ହୁ ଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ
ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ସ୍ଥାପି ତ ହେବ?

41 − 2 ÷ 1 + 66 × 6 = ?

A.  65

B.  72

C.  88

D.  91
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✓

Q96 Reasoning

S ବି ନ୍ଦୁ  A ରୁ  ଆରମ୍ଭ କରି  ପୂ ର୍ବ  ଦି ଗକୁ  29 km ଗାଡି  ଚଲାନ୍ତି  । ତା' ପରେ ସେ ଡାହାଣ ମୋଡ଼
ନେଇ 33 km ଗାଡି  ଚଲାନ୍ତି , ସେ ପୁ ନର୍ବା ର ଡାହାଣ ମୋଡ଼ ନେଇ 45 km ଗାଡି  ଚଲାନ୍ତି  ।
ସେ ପୁ ନର୍ବା ର ଡାହାଣ ମୋଡ଼ ନେଇ 45 km ଗାଡି  ଚଲାନ୍ତି  । ସେ ଅନ୍ତି ମ ଡାହାଣ ମୋଡ଼ ନେଇ
16 km ଗାଡି  ଚଲାଇ ବି ନ୍ଦୁ  P ରେ ଅଟକି  ଯାଆନ୍ତି  । ବି ନ୍ଦୁ  A ରେ ପୁ ନର୍ବା ର ପହଞ୍ଚି ବା ପାଇଁ  ସେ
କେତେ ଦୂ ର (ସର୍ବ ନି ମ୍ନ  ଦୂ ରତା) ଏବଂ କେଉଁ  ଦି ଗକୁ  ଗାଡି  ଚଲାଇବା ଉଚି ତ? (ଯଦି  ଦି ଆଯାଇ
ନାହିଁ ତେବେ ସମସ୍ତ ମୋଡ କେବଳ 90 ଡି ଗ୍ରୀ  ଅଟେ ।)

A.  12 km ଉତ୍ତର ଦି ଗକୁ

B.  11 km ପୂ ର୍ବ  ଦି ଗକୁ  

C.  12 km ପଶ୍ଚି ମ ଦି ଗକୁ

D.  12 km ଦକ୍ଷି ଣ ଦି ଗକୁ

✓

Q97 Reasoning
D, E, F, G, Q, R ଏବଂ S ଙ୍କ ମଧ୍ୟରୁ  ପ୍ର ତ୍ୟେକଙ୍କର ସୋମବାରରୁ  ଆରମ୍ଭ ହୋଇ
ରବି ବାରରେ ଶେଷ ହେଉଥି ବା ଗୋଟି ଏ ସପ୍ତାହର ଭି ନ୍ନ ଭି ନ୍ନ ଦି ନରେ ପରୀକ୍ଷା ଅଛି  । E ଏବଂ
Q ଙ୍କ ମଧ୍ୟରେ କେବଳ ତି ନି  ଜଣ ଲୋକଙ୍କର ପରୀକ୍ଷା ଅଛି  । ସପ୍ତାହର ଶେଷ ଦି ନରେ Q
ଙ୍କର ପରୀକ୍ଷା ଅଛି  । D ଙ୍କ ପରେ ଦ୍ୱି ତୀୟ ଦି ନରେ G ଙ୍କ ପରୀକ୍ଷା ଅଛି  । S ଙ୍କ ଠି କ ପୂ ର୍ବ  ଦି ନ R
ଙ୍କ ପରୀକ୍ଷା ଅଛି  । ଶୁ କ୍ର ବାର ଦି ନ F ଙ୍କ ପରୀକ୍ଷା ନାହିଁ । F ଏବଂ R ଙ୍କ ମଧ୍ୟରେ କେତେ ଜଣ
ଲୋକଙ୍କର ପରୀକ୍ଷା ଅଛି ?

A.  ଚାରି

B.  ତି ନି

C.  ଦୁ ଇ 

D.  ଏକ

✓

Q98 Reasoning
ଦି ଆଯାଇଥି ବା ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ  ଗୁ ଡ଼ି କୁ  ଧ୍ୟାନପୂ ର୍ବ କ ଅଧ୍ୟୟନ କରନ୍ତୁ । ସାଧାରଣ ଜଣାଶୁ ଣା
ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ବୋଲି  ପ୍ର ତୀତ ହେଲେ ମଧ୍ୟ ଏହି  ବି ବୃ ତି ଗୁ ଡ଼ି କରେ ପ୍ର ଦତ୍ତ ତଥ୍ୟକୁ  ସତ୍ୟ
ଭାବରେ ବି ବେଚନା କରନ୍ତୁ ଏବଂ ବି ବୃ ତି ରୁ  ତର୍କ ସି ଦ୍ଧ ଭାବରେ ଅନୁ ସୃ ତ ନି ଷ୍କର୍ଷ ଟି /ଗୁ ଡ଼ି କ
ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

ବି ବୃ ତି : ସମସ୍ତ ସ୍କୁଲ କଲେଜ ଅଟେ । ସମସ୍ତ କଲେଜ ବି ଶ୍ୱବି ଦ୍ୟାଳୟ ଅଟେ

ନି ଷ୍କର୍ଷ  (I): ସମସ୍ତ ସ୍କୁଲ ବି ଶ୍ୱବି ଦ୍ୟାଳୟ ଅଟେ
ନି ଷ୍କର୍ଷ  (II): କି ଛି  କଲେଜ ସ୍କୁଲ ଅଟେ

A.  କେବଳ ନି ଷ୍କର୍ଷ  I ଅନୁ ସରଣ କରେ

B.  କେବଳ ନି ଷ୍କର୍ଷ  II ଅନୁ ସରଣ କରେ

C.  ଉଭୟ ନି ଷ୍କର୍ଷ  I ଏବଂ II ଅନୁ ସରଣ କରେ

D.  ନି ଷ୍କର୍ଷ  I କି ମ୍ବା II କୌଣସି ଟି  ଅନୁ ସରଣ କରେନାହିଁ

✓

Q99 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ପୁ ଞ୍ଜ ଯୋଡ଼ି  ମଧ୍ୟରୁ
ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି
। କେଉଁ ଟି  ସେହି  ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  HP-UO

B.  BJ-OK

C.  DL-QK

D.  GO-TN

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ କ୍ର ମ ଆଧାରରେ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । (ଗଣନା କେବଳ ବାମରୁ  ଡାହାଣକୁ
କରାଯି ବ । ସମସ୍ତ ସଂଖ୍ୟା କେବଳ ଏକ ଅଙ୍କ ବି ଶି ଷ୍ଟ ସଂଖ୍ୟା ଅଟେ ।)
(ବାମ) 2 6 7 1 8 5 4 9 3 2 6 8 4 5 7 1 5 7 9 4 1 3 6 2 9 3 5 7 1 (ଡାହାଣ)
ଏପରି  କେତୋଟି  ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ଅଯୁ ଗ୍ମ  ଅଙ୍କ ଏବଂ
ଠି କ ପରେ ଏକ ଯୁ ଗ୍ମ  ଅଙ୍କ ମଧ୍ୟ ଅଛି ?

A.  ତି ନି ରୁ  ଅଧି କ

B.  ଏକ

C.  ଦୁ ଇ

D.  ତି ନି
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